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 This guide was created to help students ensure proper formatting of their dissertations 

and should be used in concert with the Crummer EDBA Dissertation Guide 2022 v2.2 and the 

Crummer EDBA Dissertation Template 2022 v2.2.  This guide will provide step-by-step 

instructions for Microsoft Word operations that are necessary for the correct formatting of the 

dissertation. 

For additional help you can contact the Writing Coach Christopher Posey 

(cposey@rollins.edu or 407-670-9283). 

  

mailto:cposey@rollins.edu
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Chapter 1: The Ruler 

 Several operations and standards required in the composition of the dissertation will rely 

on precise placement of tabs, correct positioning of indents, and centering of text.  These all 

require seeing the Ruler Feature in Word.  To access the Ruler:  

Step 1. Click on the View Tab of the Toolbar 

 

Step 2. Check the checkbox in front of Ruler 

 

This will add Rulers to your viewing pane on both the top and left side. 

The Ruler shows Indent Markers (Triangular & Rectangular) for both right and left margins. 

 

For explanations on using Indent Markers see below; different sections of the dissertation 

require different indent styles (e.g., standard or hanging indents), and some elements require 

special indents at unusual positions (e.g., List of Tables, List of Figures, and hypotheses). 
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Chapter 2: Changing Measurement Systems 

 Not all students may have US settings set up on their personal computers, meaning that 

their paper size and settings, like the use of inches in margins, may not be applied at the start of 

the program.  To assist with changing these settings you can follow the instructions below. 

Step 1. Click on the File Menu 

 

Steps 2-5. Choose Options at the bottom of the sidebar menu, then Choose Advanced on the 

Word Options popup menu, Scroll down to the Display section, and from the drop down menu 

at “Show measurements in units of” Choose Inches.  
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Chapter 3: Adding Tabs 

 There are three variations of tab settings in your document, these include those for Table 

of Contents, equations, and Lists of Tables and Figures.   

Table of Contents 

 The Table of Contents will list all your Chapter headers, as well as your subheadings 

down to Level 3 Headers.  These headers have page numbers preceded by a string of dots 

between the last letter of the title and the number aligned to the right margin.  It is impossible to 

correctly align page numbers along the right margin using a line of periods after a header as the 

letters and numbers in Word are all different widths (e.g., “Weights and Values” made up of 16 

letters and 2 spaces fits in a smaller amount of space than “Invested in Stocks”). Using periods 

only leads to crooked numbering. Instead, use a right aligned tab, set with a dotted line leader. 

To set up the necessary tabs you just need to follow the steps below, repeating Step 4 for 

each individual tab. 

 Step 1. From the Line Spacing dropdown menu Click Line Spacing Options 
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Step 2. In the Paragraph Popup Box Click the Tabs button. 

 

Steps 3-6. Enter the Tab Measurement in the Tab stop position field. Choose Alignment setting. 

Define Leader, if applicable. Click Set. 

 

Settings for the necessary tabs are as follows: 0.25, Left alignment, Leader 1 None; 0.5, 

Left alignment, Leader 1 None; 0.75, Left alignment, Leader 1 None; and 6.5, Right alignment, 

Leader 2…..  

 If you have incorrect tabs, you can Click on them in the list and Click the Clear button.  
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Tabbing for Equations 

 In some dissertations the use of mathematical equations is required and APA requires that 

they are formatted a specific way, with the equation centered in a separate line and numbered.  

The number is in paratheses at the right margin.  See an example below. 

 Σt
2 = 0.5(ht – lt )

2 – (2 log (2) – 1) (ct – ot )
2 (1) 

To do this set the following tabs: 3.25, Center alignment, Leader 1 none; 6.5, Right alignment, 

Leader 2……. 

 

Lists of Tables and Figures 

The List of Tables and List of Figures are configured differently, and each has different 

tab setting for the header row and the actual list of tables and figures, so as they look like this: 

 

Table Page 

1. Title of Your Table .......................................................................................................... 12 

2.  The Title of the Next Table .............................................................................................. 13 

 

The header row needs a tab at 6.5, with right alignment, but the Leader 1 none, while the 

actual list requires a tab at 6.44, Right alignment, Leader 2….. as its setting. 

Additionally, the lefthand margin needs to be modified for a hanging indent. This is 

accomplished as shown below (for further information on changing Indents see the next chapter). 
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Steps 1 & 2 Click and Drag the downward triangular Indent Mark to between the 2nd and 3rd 

notches. Click and Drag the upward triangular Indent Mark to the half-inch notch (the middle 

between the left margin and 1 on the Ruler. 
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Chapter 4: Using Indent Marks 

Centering Text when the Auto-Indent Feature is Active 

 As you type, Word will recognize that you are indenting your paragraphs, and will start 

to Auto-Indent them for you (when you hit Enter, the cursor will drop to the next line, but sit at 

the .5-inch indent rather than flush with the left margin). This feature is very helpful, except in 

one aspect.  When you wish to add a new centered chapter header (a quick way to do that is to 

have your cursor on the line you are centering and hold Ctrl and press E), Word will center the 

text using the right margin and the indent position, instead of the left margin. This means that 

your title will be off center.  To fix this:  

Step 1. Click and Drag the downward triangular Indent mark to align with the upward 

triangular and rectangular Indent markers at the left margin (it should snap into place). 
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Hanging Indents in References 

 The reference section of your dissertation requires the entries to start at the left margin 

will all runover text being indented half an inch so that the author’s names stand out to a reader.  

This is accomplished with a hanging indent.  

Step 1 Click and Drag the upward triangular Indent Mark to the half-inch notch. 

 

 Be sure to click ONLY the upward triangular Indent Mark as including the rectangular 

Indent Mark will cause both triangular Indent Marks to move as a unit. 

Indenting Hypotheses 

 To draw attention to hypotheses stated in a dissertation, use a modified indentation set at 

a uniform quarter inch. 

Step 1 Click and Drag the rectangular Indent Mark to move all three markers to the quarter 

inch position. 
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Chapter 5: Turning Off Default Extra Line Spacing After Paragraphs 

 Word added extra line spacing after paragraphs by default.  This means every paragraph 

is spaced half a line extra from the one above it.  Crummer Dissertations does not allow this. To 

remove it, you simply need to position your cursor in the first paragraph you write and: 

Step 1. Click the down arrow on the Line and Paragraph Spacing icon on the toolbar and Click 

on Remove Space After Paragraph. 

 

If you find other paragraphs in your document have extra spacing before (or after) 

paragraph breaks you can use the above method to remove them. 
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Chapter 6: Page Orientation for Extra-Wide Tables and Figures 

 When you insert a table or figure into your dissertation that is too wide for the margins, change the orientation of the page(s) it 

occupies to maintain 12pt font size.  To accomplish this, position your cursor at the top of your table or figure and follow these steps.  

Steps 1-3 From the Layout menu, Click Breaks, and Choose Next Page from the Section Breaks portion of the dropdown menu. 

 

Then reposition your cursor to the bottom of your table or figure and repeat the steps above (Layout – Breaks – Next Page). 
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 This effectively separates the page(s) the table resides in from the rest of the document settings, so things like numbering and 

orientation can be altered without changing them globally.  To complete the orientation, move your cursor any place within your table 

or figure page(s) and then follow the remaining steps. 

Steps 3 & 5 Still in the Layout Menu, Click the down arrow under the Orientation icon and Click on Landscape from the choices 

listed. 

 

 You will need to amend the page numbering of the document to ensure consistency. See page 12 of the Adjusting Page 

Numbering chapter for details (below).   
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Chapter 7: Adjusting Page Numbering 

 Your dissertation employes two different numbering schemes.  The first is roman 

numerals that number the initial pages of the paper (from the cover page through your list of 

figures). The second is Arabic numbers for the body of the paper (Chapter 1 through your 

appendices).  To ensure correct numbering, and proper format, follow the steps in this section.  

No Page Number on Cover Page 

 You will note that the cover page of your dissertation doesn’t have a number in the 

bottom margin like all the rest of the pages.  But it does, it’s just hidden.  To ensure that this is 

the case with your dissertation, follow these steps: 

Steps 1-3 Double Click on the page number at the bottom of the page to open the Footer. 

Highlight the number. In the Header & Footer menu, Click the Different First Page 

checkbox. 

 

Fixing Out of Sync Page Numbering 

Using Section Breaks will interrupt page numbering, and you will often have to rectify 

this manually.  Follow the steps below to get your page numbering back in order once you have 

changed the orientation of your pages. 
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Steps 1 & 2 As above, Double Click the first incorrect page number. Highlight it once the 

Footer opens.  

 

Steps 3 & 4 Right Click on the highlighted number. Click Format Page Numbers from the 

popup menu 

 

Step 4 Click Continue from previous section and OK 
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Keyboard Shortcuts 

This chapter provides a few keyboard shortcuts to make your writing exercise a bit 

smoother.  They are very helpful when you are working very hard, as they allow you to skip 

moving your mouse all the way up to the toolbar, finding the right menu, locating the correct 

icon before returning to the text.  

Copy and Paste 

 To copy text, a table, figure, or image, just highlight it with your mouse, and then hold 

down the Control (Ctrl) key and press C.  This will copy it on your clipboard, allowing you to 

move your cursor to the new location you want the copy placed.  Then just hold down Ctrl and 

press V.  

Cut and Paste 

 This works the same way, except instead of copying the selection it deletes it, removing it 

from the original location and allowing you to move it to a new one. Hold Ctrl and press X, then 

just paste the selection where you want with the above-mentioned Ctrl + V. 

Center/Uncenter 

 To center or left align a selection, simply place your cursor in or on the item or text and 

hold down Ctrl and press E; if the item or text is centered it will move it to left alignment, and 

vice versa. 

Bold and Italics 

 To make text Bold, you need only hold Ctrl and press B; likewise, to make text Italic 

hold Ctrl and press I. 
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Find Text 

 If you want to search for a specific word or phrase in your document, you can just by 

highlighting the word or phrase and holding Ctrl and press F, this opens the Navigation sidebar, 

which will display the results, showing you every instance where that word or phrase appear in 

the file.  By clicking on any of the results you can go to each one. 

Replacing Text 

 If you have a word or phrase across every instance in your document you can quickly 

bring up the Find and replace popup window by highlighting the word or phrase and holding 

Ctrl press H. 

 


